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Tiết 1
	Thứ hai, ngày 17 tháng 2 năm 2025
Tin học 
Bài 5. Thực hành soạn thảo văn bản có ảnh minh họa


I. YÊU CẦU CẦN ĐẠT

- Soạn thảo được văn bản theo chủ đề và có ảnh minh họa.

- Chọn được cách bố trí ảnh trong văn bản theo yêu cầu.
1. Về năng lực

 Năng lực chung:

· Năng lực giao tiếp và hợp tác: Trao đổi, giúp đỡ nhau trong học tập; cùng bạn hoàn thành việc soạn thảo văn bản theo chủ đề.
Năng lực Tin học:
· Năng lực NLd: Thực hiện được các thao tác soạn thảo văn bản theo chủ đề mà em thích.
2. Về phẩm chất

· Chăm chỉ: Hăng hái, tích cực thực hiện nhiệm vụ học tập trong soạn thảo văn bản theo chủ đề cho trước.
· Trách nhiệm: Hoàn thành đầy đủ các nhiệm vụ học tập trong việc soạn thảo văn bản theo chủ đề có ảnh minh họa.
II. ĐỒ DÙNG DẠY – HỌC


- GV: SGK, SGV, bài giảng điện tử.


- HS: SGK, SBT, vở ghi.

III. CÁC HOẠT ĐỘNG DẠY HỌC

	Hoạt động của GV
	Hoạt động của HS


	- Kiểm tra sĩ số.

1. Khởi động, trải nghiệm
Mt: Tạo hứng thú cho HS. Củng cố lại thao tác thay đổi vị trí của ảnh 

- Gv chiếu 2 văn bản hình 1 và hình 2 trang 42 SGK. 
- Gọi 1số HS cho biết:  Em thích cách bố trí ảnh nào hơn? Tại sao? Nêu lại cách di chuyển ảnh vào vị trí em thích.
- Gọi HS khác nhận xét
- GV nhận xét, tuyên dương và chốt: 

+ Văn bản hình 2 đẹp  và phù hợp hơn

+ Cách di chuyển ảnh vào vị trí em thích: Chọn ảnh -> Nháy chuột vào dải lệnh Picture Format -> Wrap Text -> Square -> kéo thả ảnh đến vị trí em thích.

- GV dẫn dắt giới thiệu bài, ghi đầu bài lên bảng
2. Thực hành, luyện tập 

Hoạt động 2.1: Thực hành soạn thảo văn bản theo chủ đề và có ảnh minh họa
MT: HS thực hành soạn thảo được văn bản tương tự mẫu cho trước
- GV chiếu yêu cầu. Cho HS đọc thầm phần hướng dẫn thực hành SGK trang 42, thảo luận theo nhóm máy rồi thực hiện tạo 1 tệp văn bản mới theo chủ đề “Chúc mừng mẹ nhân ngày 8-3” tương tự mẫu hình 2, lưu và đặt tên là Con tặng mẹ
- GV theo dõi, hỗ trợ HS yếu

- Nhận xét, tuyên dương, chấm 1 số HS

- Gọi đại diện1 số nhóm đã thực hiện  được nêu lại cách thực hiện

- Gọi HS nhóm khác nhận xét

- GV nhận xét, tuyên dương

- GV nhận xét và chốt lại cách làm: 
+ Tạo tệp mới: File -> New

+ Chèn ảnh: Insert -> Picture

+ Thay đổi vị ví ảnh: Wrap Text -> Square

+ Lưu văn bản: File ->Save

3.Vận dụng, trải nghiệm
MT: HS thực hành soạn thảo được văn bản theo chủ đề em thích

- Gv chiếu yêu cầu
- Cho HS thực hành soạn thảo văn bản theo chủ đề em thích, chèn ảnh minh họa, lưu lại tệp đó.

-  GV theo dõi, hỗ trợ HS yếu

- Nhận xét, tuyên dương, chấm 1 số HS

- GV chiếu lại các phần chốt kiến thức
- Gọi 1 HS đọc to trước lớp

- Dặn HS về nhà học thuộc phần chốt kiến thức
	- Quan sát

- Nêu ý kiến

- Nhận xét

- Lắng nghe, vỗ tay

- Nghe, ghi đầu bài vào vở

- Đọc yểu cầu, thảo luận và thực hiện trên máy

- Lắng nghe, vỗ tay

- Đại diện 1 số nhóm trả lời

- Nhận xét

- Lắng nghe, vỗ tay

- Lắng nghe

- Đọc yểu cầu, thực hiện trên máy

- Lắng nghe, vỗ tay

- Quan sát

- 1 HS đọc to trước lớp

- Ghi nhớ


IV. Điều chỉnh sau bài dạy
………………………………………………..……………………………………………….……………………………………………….…………………………


	Lớp: 4A

	

Thứ  hai, ngày  17  tháng 2 năm 2025
Công nghệ

Bài 9. Lắp ghép mô hình cái đu (tiết 2)


I. Yêu cầu cần đạt:

Bài học này nhằm hình thành và phát triển ở HS năng lực và phẩm chất với những biểu hiện cụ thể như sau:

1. Năng lực

a. Năng lực công nghệ

- Năng lực nhận thức công nghệ: Nhận biết được các bộ phận chính và yêu cầu sản phẩm mô hình cái đu

- Năng lực sử dụng công nghệ:

+ Lựa chọn được dụng cụ và chi tiết để lắp ghép mô hình cái đu đúng yêu cầu.

+ Sử dụng được một số dụng cụ và chi tiết để lắp ghép được mô hình cái đu theo hướng dẫn.

+ Sử dụng, chơi đúng cách mô hình cái đu

- Năng lực đánh giá công nghệ: Giới thiệu được sản phẩm do mình làm và nhận xét được sản phẩm theo các tiêu chí đánh giá.

b. Năng lực chung

- Năng lực tự chủ và tự học: Tự lực lắp ghép được mô hình theo sự phân công, hướng dẫn và đúng thời gian quy định.

- Năng lực giao tiếp và hợp tác: Biết giúp đỡ bạn cùng lắp ghép mô hình hoàn chỉnh.

- Năng lực giải quyết vấn đề và sáng tạo: Hình thành được ý thức làm việc theo quy định.

2. Phẩm chất

- Chăm chỉ: Có ý thức thực hành nghiêm túc, luôn cố gắng đạt kết quả tốt.

- Trách nhiệm: Có ý thức giữ gìn dụng cụ, chi tiết lắp ghép, nhắc nhở mọi người chấp hành đúng quy định về gọn gàng, ngăn nắp sau giờ học.

II. Đồ dùng dạy học

- Bộ lắp ghép mô hình KT; danh mục chi tiết, dụng cụ cần dùng để lắp một mô hình cái đu.

- Một số hình ảnh mô hình cái đu và tiến hành lắp ghép mô hình cái đu trong SGK

- Một số mô hình cái đu

- Video hướng dẫn các bước tiến hành lắp ghép mô hình cái đu

- Máy tính, máy chiếu

III. Các hoạt động dạy học chủ yếu

	Hoạt động của GV
	Hoạt động của HS

	1. Hoạt động khởi động

a. Mục tiêu: Tạo hứng thú và nhu cầu tìm hiểu cách lắp ghép mô hình cái đu

b. Tổ chức thực hiện

	2. Hoạt động khám phá

C. Lắp ghép mô hình

Lắp ghép mô hình cái đu theo hướng dẫn.

a. Mục tiêu: Sử dụng được một số dụng cụ và chi tiết để lắp ghép được mô hình cái đu theo hướng dẫn

b. Tổ chức thực hiện

	

	Nhiệm vụ 1: Làm mẫu quan sát

- Sử dụng các dụng cụ, chi tiết đã lựa chọn làm mẫu từng bước lắp ghép mô hình cái đu. Thao tác làm mẫu đảm bảo tất cả HS trong lớp đều có thể quan sát được.

- GV vừa làm vừa nêu các bước thực hiện, lưu ý một số thao tác khó:

Bước 1: Dùng vít ngắn để ghép ở thao tác 1 và 2, thao tcas 3 phải dùng vít nhỡ vì phải ghép 3 chi tiết

Bước 2 (thao tác 2): Lắp ghép thành sau và tay cầm với mặt ghế ngồi (chú ý vị trí các thanh 7 lỗ)

Bước 2 (thao tác 3): Lắp trục vào tay cầm theo thứ tự: Đưa một đầu trục qua 2 thanh 7 lỗ, sau đó lồng 2 vòng hãm rồi xuyên qua 2 thanh 7 lỗ còn lại. Lắp 2 vòng hãm vào đầu trục rồi đẩy các vòng hãm về đúng vị trí như trong hình của SGK 

- Sau khi lắp xong hai bộ phận chính của cái đu GV đặt câu hỏi và trong SGK trang 47 yêu cầu trả lời: Hai bộ phận chính của cái đu sẽ được ghép với nhau bằng chi tiết nào?

- Gọi 1-2 HS trả lời

- Nhận xét và đưa đáp án: Hai bộ phận chính của cái đu sẽ được ghép với nhau bằng ốc và vít ngắn.

- Chốt trình tự các bước chính lắp ghép mô hình cái đu
	- Nghe, quan sát làm mẫu

- Nghe, quan sát để thực hiện

- Đọc câu hỏi và trả lời

- Nhận xét bạn và bổ sung



	3. Hoạt động luyện tập thực hành

Nhiệm vụ 2. Thực hành lắp ghép mô hình cái đu

	- Phân chia nhóm thực hành, mỗi nhóm chuẩn bị đầy đủ số lượng các dụng cụ, chi tiết cho tất cả thành viên sử dụng.

- Lưu ý một số thao tác khó và hỗ trợ các nhóm HS khi cần thiết

- Sau khi hoàn thành, yêu cầu HS chơi thử mô hình cái đu, điều chỉnh để hoạt động tốt.

- Để tăng cường khả năng sáng tạo của HS, yêu cầu các nhóm thảo luận các ý tưởng trang trí thêm trên mô hình cái đu.
	- Mỗi HS tự làm một sản phẩm theo các bước cho trước

- Các thành viên trong nhóm có thể thảo luận, hướng dẫn bạn cùng thực hiện các bước đảm bảo yêu cầu kĩ thuật, thẩm mĩ.

- Thảo luận, lựa chọn và thực hiện trang trí sản phẩm theo ý thích của mình.


IV. Điều chỉnh sau bài dạy
………………………………………………..………………………………………………………….……………………………………………………….………

	Lớp: 4C

	Thứ ba, ngày 18 tháng 02 năm 2025
Tin học 

Bài 5. Thực hành soạn thảo văn bản có ảnh minh họa

	
	Công nghệ

Bài 9. Lắp ghép mô hình cái đu (tiết 2)


**Đã soạn như bài của lớp 4A vào chiều thứ hai, ngày 17/2/2025

	Lớp: 5A


	Thứ ba, ngày 18 tháng 2 năm 2025
Tin học
Bài 3. Trang phục của nhân vật


I. Yêu cầu cần đạt:

1. Về năng lực:

Năng lực chung:

+ Năng lực tự chủ và tự học: Tìm hiểu và tạo được chương trình với yêu cầu cho trước.

+ Năng lực giao tiếp và hợp tác: Trao đổi thảo luận nhóm để cùng thực hành.

+ Năng lực giải quyết vấn đề và sáng tạo: Khi gặp một vấn đề trong tạo chương trình biết chọn lựa cách giải quyết phù hợp nhất.

Năng lực tin học:

+ Năng lực NLe: Tạo được chương trình vẽ hình đơn giản với hai nhóm lệnh Bút vẽ và Chuyển động.

2. Về phẩm chất:
+ Chăm chỉ: Hăng hái, tích cực thảo luận nhóm để làm bài thực hành.

+ Trách nhiệm: Hoàn thành đầy đủ nhiệm vụ, hướng dẫn bạn cùng nhóm thực hành .

II. Đồ dùng dạy học:

GV: SGK, SBT. HS: SGK, SBT
III. Các hoạt động dạy và học:

	Hoạt động của giáo viên
	Hoạt động của học sinh

	1. Hoạt động khởi động (3’)

a. Mục tiêu: Tạo tâm thế vào bài học mới cho HS, gợi mở về bài học

b. Tổ chức hoạt động:

	- GV nêu yêu cầu của phần khởi động và gọi 1 HS lên thực hiện nhiệm vụ.

- GV gọi đại diện HS trả lời câu hỏi

- GV chốt kiến thức: 
- GV gợi mở vào bài học 
	- HS lắng nghe để thực hiện nhiệm vụ

- Trả lời câu hỏi
- Nghe
- Nghe

	2. Hoạt động luyện tập, thực hành

Hoạt động 2.1. Thực hành tạo chương trình vẽ hình vuông. (15’)

a. Mục tiêu: Học sinh thực hành được yêu cầu của bài.

b. Nội dung và sản phẩm:

- Kiến thức: Biết sử dụng lệnh đặt kích thước bút và đặt bút.

- Yêu cầu: Thực hiện bài thực hành trong SGK trang 50.

- Sản phẩm: Hoàn thiện bài thực hành trong SGK trang 50.

c. Tổ chức hoạt động:

	- GV yêu cầu đọc yêu cầu của bài thực hành trong SGK trang 50.
- GV nêu một số câu hỏi gợi ý:

+ Bài cho biết gì?

+ Bài yêu cầu gì?

- Gọi 1HS trả lời các câu hỏi gợi ý.

- Yêu cầu HS đọc phần hướng thực hành trong SGK trang 51.

- Gọi HS trả lời: Để thực hiện bài thực hành trên ta thực hiện mấy bước?

- Gọi HS đọc từng bước GV làm mẫu, cả lớp quan sát GV thực hiện.

- Chia nhóm 2 HS một máy yêu cầu HS thực hiện bài thực hành.

- GV quan sát hướng dẫn HS gặp khó khăn.

- Gọi 1 nhóm HS lên trình bày cách làm

- Gọi 1 HS nhận xét bài của nhóm bạn.

- GV nhận xét, tuyên dương.
	- Đọc yêu cầu
- Nghe

- 1HS trả lời:

+ Bài cho biết: Cạnh hình vuông có độ dài 100 bước.

+ Bài yêu cầu: Tạo chương trình vẽ hình vuông.

- Đọc hướng dẫn

- Trả lời: Thực hiện gồm 3 bước.

- HS đọc

- Chia nhóm thực hiện.

- Hỏi lại GV nếu cần.

- Trình bày bài

- Nhận xét

- Nghe

	Hoạt động 2.2. Thực hành tạo chương trình vẽ hàng cây.(12’)

a. Mục tiêu: Giúp HS luyện tập các khối lệnh dùng bút vẽ.

b. Nội dung và sản phẩm:
- Kiến thức: Sử dụng các lệnh trong nhóm lệnh bút vẽ. 

- Yêu cầu: Thực hiện bài thực hành trang 51 SGK.

- Sản phẩm: Hoàn thiện bài thực hành trang 51 SGK.

c. Tổ chức hoạt động:

	- Yêu cầu đọc nội dung bài thực hành trang 51 SGK.

- GV nêu một số câu hỏi gợi ý:
+ Bài cho biết gì?

+ Bài yêu cầu gì?

- Gọi HS lên chia sẻ

- Yêu cầu đọc hướng dẫn thực hành

- Trả lời câu hỏi: Để thực hiện được bài thực hành em sử dụng mấy bước?

- Chia nhóm 2 HS một máy thực hành

- Gọi 1 HS thực hiện trên máy của GV

- GV quan sát hướng dẫn HS gặp khó khăn

- Gọi HS nhận xét bài của bạn trên máy GV

- GV nhận xét, tuyên dương.
	- Đọc yêu cầu.

- Nghe

- Chia sẻ nội dung với câu hỏi gợi ý, một HS hỏi, 1 HS trả lời:

+ Bài cho biết: Hàng cây như Hình 4 trong SGK.

+ Bài yêu cầu: Tạo chương trình vẽ hàng cây, hàng cây có 5 cây và hai cây cạnh nhau cách nhau 100 bước.

- Đọc hướng dẫn thực hành.

- Trả lời: Để thực hiện được bài thực hành em sử dụng 4 bước.

- Thực hành 

- Thực hiện

- Hỏi lại GV nếu cần

- Nhận xét

- Nghe.

	3. Hoạt động vận dụng (5’)

a. Mục tiêu: HS biết vận dụng vẽ các hình với thông tin cho trước.
b. Nội dung và sản phẩm:
- Yêu cầu: Thực hiện bài vận dụng trong SGK trang 52.
- Sản phẩm: Hoàn thành bài vận dụng.

c. Tổ chức hoạt động:

	- GV nêu yêu cầu của bài vận dụng.

- Thực hiện chung cả lớp hoặc giao nhiệm vụ về nhà thực hiện.
	- Nghe

- Nghe


IV. Điều chỉnh sau bài dạy
…….……………………………………………….………………………………

	Lớp: 5A
	

Thứ  ba, ngày  18  tháng 02 năm 2025
Công nghệ
Bài 8. Lắp ráp mô hình xe điện chạy bằng pin (tiết 4)


I. YÊU CẦU CẦN ĐẠT

1.Năng lực đặc thù.
- Năng lực công nghệ: Kể tên, nhận biết được các chi tiết của bộ lắp ghép mô hình xe điện chạy bằng pin. 

Lắp ráp, vận hành được mô hình xe điện chạy bằng pin.
2. Năng lực chung
- Năng lực tự chủ, tự học: HS tự tin khi tìm hiểu về quá trình lắp ráp mô hình; HS chủ động khám phá bài học và tự nhận xét được kết quả học tập của mình, của bạn.

- Năng lực giải quyết vấn đề và sáng tạo: Lắp được một số mô hình xe điện chạy bằng pin ngoài sách giáo khoa.

- Năng lực giao tiếp và hợp tác: HS có khả năng giao tiếp, trình bày ý tưởng khi làm việc nhóm để hoàn thành các bài tập được giao.

3. Phẩm chất

- Phẩm chất chăm chỉ: HS chuẩn bị bài trước khi đến lớp, hăng say tìm tòi, mở rộng hiểu biết và vận dụng được kiến thức đã học.


- Phẩm chất trách nhiệm: Hoàn thành các nhiệm vụ học tập, nắm được và thực hiện tốt nhiệm vụ khi làm việc nhóm.


II. ĐỒ DÙNG DẠY HỌC


- Máy tính, máy chiếu, SGK.


- Mô hình mẫu, phiếu học tập.


III. CÁC HOẠT ĐỘNG DẠY HỌC CHỦ YẾU

	Hoạt động của GV
	Hoạt động của HS

	1. Khởi động

- Mục tiêu:
+ Khơi gợi vốn hiểu biết sẵn có của học sinh và tạo nên không khí lớp học hào hứng, vui tươi.

- Cách thực hiện:

	- Hát và vận động theo bài hát: Em lái xe ô tô.

- GV dẫn dắt vào bài: Giờ học hôm nay chúng ta sẽ cùng nhau thực hành để lắp ráp được mô hình xe điện chạy bằng pin ngoài SGK.
	- HS hát và vận động theo.

	2. Hoạt động khám phá

- Mục tiêu:
+ HS ý tưởng thiết kế sản phẩm lắp ghép mô hình xe điện chạy bằng pin.

+ HS vẽ phác thảo sản phẩm.

- Cách thực hiện:

	- GV đưa ra một số hình ảnh về các sản phẩm lắp ghép mô hình xe điện chạy bằng pin.
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- GV chia lớp thành các nhóm. Tổ chức cho HS vẽ và phác thảo ý tưởng.

- GV quan sát, giúp đỡ các nhóm.

- Mời các nhóm trưởng báo cáo ý tưởng nhóm mình.

- GV tổng kết, khen ngợi các nhóm có ý tưởng tốt.
	- HS quan sát.
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- HS hoạt động theo nhóm.

- Nhóm trưởng báo cáo.

- Nhóm khác nhận xét, bình chọn nhóm có ý tưởng tốt nhất.

	3. Hoạt động thực hành

- Mục tiêu:
+ HS thực hành lắp ghép mô hình xe điện chạy bằng pin ngoài SGK
- Cách thực hiện:

	- Yêu cầu HS chuẩn bị đồ dùng và hoàn thành sản phẩm.
- GV hỗ trợ HS gặp khó khăn
- Sau khi hoàn thành yêu cầu HS thu dọn và trưng bày sản phẩm.
	- HS chuẩn bị đồ dùng và hoàn thành sản phẩm.
- HS cất đồ dùng và trưng bày sản phẩm.

	4. Hoạt động vận dụng  

- Mục tiêu:
+ HS trưng bày và đánh giá sản phẩm.

- Cách thực hiện:

	- GV tổ chức cho HS quan sát sản phẩm của các nhóm mình và nhóm bạn dựa trên các tiêu chí.

- Gọi HS đọc tiêu chí
	- HS quan sát sản phẩm.

- 1HS đọc tiêu chí.
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	- Mời HS hoạt động theo nhóm, đi quan sát và đánh giá sản phẩm của các nhóm.

- GV khen ngợi các nhóm có sản phẩm đẹp và chuyển động được.

- Dặn dò: - GV yêu cầu các nhóm tiếp tục hoàn thiện sản phẩm của mình sao cho phù hợp với các tiêu chí đánh giá.

- Nhận xét tiết học.
Chuẩn bị bài: Mô hình máy phát điện gió
	- HS đi theo nhóm và đánh giá sản phẩm của nhóm bạn

- HS nghe và thực hiện


IV. Điều chỉnh sau bài dạy
…….……………………………………………….………………………………
	Lớp: 5B

	Thứ tư, ngày 19 tháng 02 năm 2025
Tin học

Bài 3. Trang phục của nhân vật

	
	Công nghệ

Bài 8. Lắp ráp mô hình xe điện chạy bằng pin (tiết 4)


** Đã soạn như bài của lớp 5A vào sáng thứ ba, ngày 18/2/2025

	Lớp: 3A

	Thứ tư, ngày 19 tháng 02 năm 2025
Tin học

Bài 3. Em tập thao tác với thư mục


I. YÊU CẦU CẦN ĐẠT

1. Kiến thức, kĩ năng:

        - Thực hiện được việc tạo, xoá và đổi tên thư mục.

        - Tìm được tệp ở thư mục cho trước.

2. Phầm chất, năng lực
a. Phẩm chất:

- Nhân ái: Yêu quý bạn bè, thầy cô; quan tâm, động viên, khích lệ bạn bè.

 - Chăm chỉ: Đi học đầy đủ, đúng giờ. Thường xuyên hoàn thành nhiệm vụ học tập.

- Trung thực: Không tự tiện lấy đồ vật, tiền bạc của người thân, bạn bè, thầy cô và những người khác.
 - Trách nhiệm: Có ý thức giữ gìn vệ sinh, rèn luyện thân thể, chăm sóc sức khoẻ. Có ý thức sinh hoạt nền nếp.

b. Năng lực:

 Năng lực chung:


- Năng lực tự chủ và tự học: Tự làm được những việc của mình ở nhà và ở trường theo sự phân công, hướng dẫn.


- Năng lực giao tiếp và hợp tác: Nhận ra được ý nghĩa của giao tiếp trong việc đáp ứng các nhu cầu của bản thân.


- Năng lực giải quyết vấn đề và sáng tạo: Biết xác định và làm rõ thông tin, ý tưởng mới đối với bản thân từ các nguồn tài liệu cho sẵn theo hướng dẫn.

Năng lực riêng:


- Học xong bài này học sinh biết các thao tác khi làm việc với thư mục.

II. ĐỒ DÙNG DẠY HỌC

1. Giáo viên: Máy tính, máy chiếu, sách giáo khoa.

2. Học sinh: Sách giáo khoa, vở ghi

III. CÁC HOẠT ĐỘNG DẠY HỌC

	HOẠT ĐỘNG CỦA GIÁO VIÊN
	HOẠT ĐỘNG CỦA HỌC SINH

	1. HOẠT ĐỘNG MỞ ĐẦU

	KTBC: Em hãy vẽ một cây thư mục sắp xếp những từ sau sao cho phù hợp: hổ, chim khuyên, cá heo, voi, chim chào mào, cá thu.

- Nhận xét – tuyên dương.

- Theo em thực hiện thao tác nào để đổi cây thư mục ở hình 1 thành hình 2.
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- Hôm nay, các em sẽ học bài “Em tập thao tác với thư mục”
	- HS thực hành vẽ cây thư mục vào vở.

- HS trưng bày sản phẩm.

- HS trả lời: Đổi tên Giai tri thành Am nhac.

- Hs viết bài.

	2. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC

	Hoạt động 1: Tạo thư mục

- Em hãy thực hiện các bước tạo thư mục theo ví dụ cho trong Hình 3. Từ đó, hãy nêu cách tạo một thư mục mới.

- Nhận xét.

- Giáo viên làm trước cho học sinh.

- Yêu cầu HS thực hiện tạo thư mục tên của mình trong ổ D:

- Chiếu thư mục của HS

- Nhận xét.

Hoạt động 2: Đổi tên, xoá thư mục

(?) Trong cây thư mục ở Hình 3, em hãy đổi tên thư mục của HS thành Hoc sinh 1 thành thư mục theo các bước sau:

1)
Chọn thư mục cần đổi tên, ở đây là thư mục tên học sinh.

2)
Nháy chuột vào lệnh Rename.

3)
Gõ tên thư mục mởi, ở đây là Hoc sinh 1 gõ Enter.

- Nhận xét.

(?) Em hãy xoá thư mục Hoc sinh 1 vừa tạo  theo các bước sau:

1)
Chọn thư mục cần xoá, ở đây là thư mục Hoc sinh 1.

2)
Nháy chuột vào lệnh Delete (hoặc nhấn phím Delete).

- Nhận xét – tuyên dương.

Hoạt động 3: Tìm tệp

- Gửi 1 thư mục Hoa có các tệp hình ảnh bên trong cho HS.

- Yêu cầu học sinh tìm tệp có tên là hoa hong.jpeg

- Nhận xét – tuyên dương.
	- Hs trả lời.

B1: Chọn thư mục sẽ tạo thư mục con bên trong nó.

B2: Nhấn New folder.

B3: Gõ tên thư mục cần tạo và nhấn Enter.

- Quan sát.

- Hs thực hiện.

- Quan sát nhận xét bạn.

- HS thực hiện đổi tên thư mục

- HS nhận xét bài bạn.

- HS thực hiện xoá thư mục

- HS nhận xét bài bạn.

- HS trả lời: mở thư mục Hoa sau đó tìm tệp có tên hoa hong.jpeg

- Hs thực hiện.

	3. HOẠT ĐỘNG LUYỆN TẬP, THỰC HÀNH

	- Em hãy tạo các thư mục để sắp xếp các loại tệp sách, báo, truyện.

- GV nhận xét – tuyên dương.
	- HS thảo luận thực hiện.

- HS tạo 3 thư mục: SACH, BAO, TRUYEN.



	4. HOẠT ĐỘNG VẬN DỤNG, TRẢI NGHIỆM

	- Yêu cầu học sinh đổi tên thư mục SACH thành HINH ANH.

- Yêu cầu học sinh xoá thư mục BAO.

GV nhận xét – tuyên dương.

- YC học sinh đọc phần em cần ghi nhớ.
	- HS thực hiện.

- HS thực hiện

- Nhận xét bài bạn.

- Hs đọc.


IV. ĐIỀU CHỈNH SAU BÀI DẠY
……………………………………………………………………………………
	Lớp 3A
Tiết 2
	Thứ tư, ngày 19 tháng 2 năm 2025
Công nghệ

Bài 7. Làm đồ dùng học tập 

(Làm thẻ đánh dấu trang - tiết 2)

	I. YÊU CẦU CẦN ĐẠT:

1. Năng lực đặc thù: Sau khi học, học sinh sẽ:

- Lựa chọn được vật liệu và sử dụng được dụng cụ phù hợp để làm đồ dùng học tập.
- Làm được một số đồ dùng học tập đơn giản theo các bước cho trước, đảm bảo yêu cầu về kĩ thuật, thẩm mĩ.
2. Năng lực chung.

- Năng lực tự chủ, tự học: Tìm tòi, học hỏi cách sử dụng các dụng cụ và vật liệu phù hợp để tạo ra các đồ dung học tập hữu ích giúp hỗ trợ việc học tập.
- Năng lực giải quyết vấn đề và sáng tạo: Đề xuất được các bước phù hợp để tạo ra một đồ dung học tập theo các bước trong SGK.

- Năng lực giao tiếp và hợp tác: Mô tả được các bước làm một dụng cụ học tập từ các dụng cụ và vật liệu thủ công. Có thói quen trao dổi, giúp đỡ nhau trong học tập, biết cùng nhau hoàn thành nhiệm vụ học tập theo sự hướng dẫn của thầy cô.
3. Phẩm chất.

- Phẩm chất chăm chỉ: Có tinh thần chăm chỉ học tập, luôn tự giác tìm hiểu bài và vận dụng sáng tạo kiến thức đã học để làm những đồ dùng học tập hữu ích giúp hỗ trợ việc học.
- Phẩm chất trách nhiệm: Có ý thức bảo quản, giữ gìn đồ dùng học tập

II. ĐỒ DÙNG DẠY HỌC 

- Kế hoạch bài dạy, bài giảng Power point.

- SGK và các thiết bị, học liệu phụ vụ cho tiết dạy.

III. HOẠT ĐỘNG DẠY HỌC
Hoạt động của giáo viên

Hoạt động của học sinh

1. Khởi động:
- Mục tiêu: 

+ Tạo không khí vui vẻ, khấn khởi trước giờ học.

- Cách tiến hành:

- GV tổ chức trò chơi “Sóc nâu tìm quả” để khởi động bài học. 

- HS tham gia chơi bằng cách bấm vào loại quả em thích và trả lời các câu hỏi:

+ Câu 1: Nêu tên đồ dùng để ghi chép các bài học
+ Câu 2: Nêu tên đồ dùng được chia thành các vạch kẻ, dùng để kẻ vẽ hình
+ Câu 3: Nêu tên đồ dùng được dùng để đựng sách vở, theo em đến trường hàng ngày
+ Câu 4: Nêu tên đồ dùng được dùng để đựng bút, thường có hình chữ nhật, được làm bằng sắt hoặc bằng nhựa
- GV Nhận xét, tuyên dương.

- GV dẫn dắt vào bài mới

- HS tham gia chơi khởi động

+ Trả lời: vở ghi
+ Trả lời: thước kẻ
+ Trả lời: cặp sách
+ Trả lời: cái hộp bút
- HS lắng nghe.

2. Luyện tập.
- Mục tiêu: 
+ Xác định được những vật liệu thủ công có thể được dùng để làm một số đồ dùng học tập.
+ Giúp Hs lựa chọn được vật liệu và dụng cụ làm đồ dùng học tập theo yêu cầu.
+ Sử dụng vật liệu và dụng cụ làm thẻ đánh dấu trang đúng cách, an toàn.

+ Làm được thẻ đánh dấu trang theo các bước đã cho trước, đảm bảo yêu cầu sản phẩm.

- Cách tiến hành:
Hoạt động 1. Chọn vật liệu làm đồ dùng học tập (làm việc nhóm 2)

- GV chia sẻ hình 2 và nêu câu hỏi. Sau đó mời các nhóm tiến hành thảo luận và trình bày kết quả.
+ Quan sát tranh 2 và cho biết những đồ dùng học tập đó có thể được làm bằng chất liệu gì?

+ Em hãy nêu tính chất của những chất liệu đó và nêu phương án giữ gìn và bảo vệ chúng?

- GV mời các nhóm khác nhận xét.

- GV nhận xét chung, tuyên dương.
- Học sinh chia nhóm 2, đọc yêu cầu bài và tiến hành thảo luận.

- Đại diện các nhóm trình bày:

+ Thẻ đánh dấu sách thường được làm từ giấy, nhựa.
+  Hộp đựng bút là sản phẩm thủ công được làm từ những vật liệu thủ công như: giấy bìa, hộp giấy, giấy màu, hồ dán,...

+ HS nêu ý kiến riêng

- Đại diện các nhóm nhận xét.

- Lắng nghe rút kinh nghiệm.

Hoạt động 2. Làm thẻ đánh dấu trang (Làm việc nhóm 4)

- GV lấy tờ giấy thủ công đã chuẩn bị và yêu cầu HS chuẩn bị 1 tờ giấy thủ công (màu tùy ý) hình vuông có cạnh là 8 ô.

- GV làm mẫu cho HS quan sát.

Bước 1: - Chọn giấy thủ công màu, vẽ hình vuông có cạnh 8cm ở mặt ô li. Cắt theo các cạnh có hình vuông như trên.
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Bước 2:  Gấp hình vuông theo đường AC ta được hình tam giác ADC.
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Bước 3: Gấp đỉnh C về D, miết tạo nếp gấp rồi mở ra. Tương tự gấp đỉnh A về D, miết tạo nếp gấp rồi mở ra.
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Bước 4: Gấp đỉnh D về điểm giữa H của cạnh AC để tạo đường nếp gấp a. Gấp đỉnh C về D.
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Bước 5: Luồn đỉnh C vào trong khe giữa theo đường nếp gấp a. Làm tương tự như đỉnh A sẽ được sản phẩm hoàn thiện.
[image: image9.png]



- GV yêu cầu HS thực hành.

+ Có những cách nào để trang trí thẻ đánh dấu trang?
- Mời đại diện các nhóm trình bày sản phẩm vừa làm xong.

- GV mời các nhóm khác nhận xét.

- GV nhận xét chung, tuyên dương.

- Học sinh lắng nghe yêu cầu bài và tiến hành thực hiện theo yêu cầu của GV.

- HS quan sát các thao tác của GV.

- HS thực hành.
+ Dùng bút màu vẽ trang trí hoặc cắt thêm chi tiết.

- Đại diện các nhóm trình bày sản phẩm của nhóm mình

- Các nhóm nhận xét.

- Lắng nghe, rút kinh nghiệm.

3. Vận dụng.

- Mục tiêu:

+ Củng cố những kiến thức đã học trong tiết học để học sinh khắc sâu nội dung.

+ Vận dụng kiến thức đã học vào thực tiễn.

+ Tạo không khí vui vẻ, hào hứng, lưu luyến sau khi học sinh bài học.

- Cách tiến hành:
- GV tổ chức trò chơi “Ai nhanh-Ai đúng”.

- Chia lớp thành 2 đội (hoặc 4 đội chơi, tuỳ vào thực tế), nối tên đồ dùng học tập và tác dụng tương ứng của chúng

- Cách chơi: 

+ Thời gian: 2-4 phút

+ Mỗi đội xếp thành 1 hàng, chơi nối tiếp.

+ Khi có hiệu lệnh của GV các đội lên nối tên đồ dùng học tập và tác dụng tương ứng của chúng

+ Hết thời gian, đội nào nối nhanh và đúng thì đội đó dành chiến thắng

- GV đánh giá, nhận xét trò chơi.

- Nhận xét sau tiết dạy, dặn dò về nhà.

- Lớp chia thành các đội theo yêu cầu GV.

- HS lắng nghe luật chơi.

- Học sinh tham gia chơi:

- HS lắng nghe, rút kinh nghiệm

IV. Điều chỉnh sau bài dạy:

....................................................................................................................................

....................................................................................................................................
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Thứ  tư, ngày 19 tháng 02 năm 2025
**Đã soạn như tiết Tin học, Công nghệ của lớp 5A vào sáng thứ 3, ngày 18/2/2025
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Thứ  năm, ngày 20 tháng 02 năm 2025
**Đã soạn như tiết Tin học, Công nghệ của lớp 3Avào sáng thứ 4, ngày 19/2/2025
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Thứ  năm, ngày 13 tháng 02 năm 2025
**Đã soạn như tiết Tin học, Công nghệ của lớp 4A vào chiều  thứ 2, ngày 10/2/2025



	Buổi chiều
Lớp: 3A
Tiết 1,2
	Thứ năm, ngày 20 tháng 02 năm 2025
Tự nhiên và xã hội
 Bài 15. Cơ quan tiêu hóa (tiết 2,3)


I. YÊU CẦU CẦN ĐẠT
1. Năng lực đặc thù: Sau khi học, học sinh sẽ:
- Chỉ và nói được tên các bộ phận chính của cơ quan tiêu hóa trên sơ đồ.

- Nêu được chức năng của cơ quan tiêu hóa.

- Trình bày được một số việc cần làm hoặc cần tránh để giữ gìn, bảo vệ cơ quan tiêu hóa.

- Làm thử nghiệm khám phá vai trò của răng, lưỡi, nước bọt trong quá trình tiêu hóa thức ăn ở khoang miệng.

- Nhận biết được chức năng của cơ quan tiêu hóa qua hoạt động ăn uống và thải bã.

2. Năng lực chung.
- Năng lực tự chủ, tự học: Có biểu hiện chú ý học tập, tự giác tìm hiểu bài để hoàn thành tốt nội dung tiết học.

- Năng lực giải quyết vấn đề và sáng tạo: Thực hiện được một số việc cần làm hoặc cần tránh để giữ gìn, bảo vệ cơ quan tiêu hóa. Có biểu hiện tích cực, sáng tạo trong các hoạt động học tập, trò chơi, vận dụng.

- Năng lực giao tiếp và hợp tác: Có biểu hiện tích cực, sôi nổi và nhiệt tình trong hoạt động nhóm. Có khả năng trình bày, thuyết trình… trong các hoạt động học tập.

3. Phẩm chất.
- Phẩm chất chăm chỉ: Có tinh thần chăm chỉ học tập, luôn tự giác tìm hiểu bài.

- Phẩm chất trách nhiệm: Giữ trật tự, biết lắng nghe, học tập nghiêm túc.

II. ĐỒ DÙNG DẠY HỌC
1. Đối với giáo viên
- Tài liệu: SGK, SGV
- Thiết bị dạy học: các hình ảnh trong SGK.

2. Đối với học sinh
- SGK, đồ dùng học tập.

III. Hoạt động dạy và học

Soạn dạy theo SGV Tự nhiên xã hội 3 
Tiết 2. Hoạt động 3 đến hết Hoạt động 5 (trang 125-126)
Tiết 3. Hoạt động 6 đến hết Hoạt động 9 (trang 126-129)

	Buổi sáng
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Thứ  sáu, ngày  21  tháng 02 năm 2025
Tự nhiên và xã hội
Bài 15. Cơ quan tiêu hóa (tiết 2,3)


**Đã soạn như tiết Tự nhiên và xã hội của lớp 3A vào chiều thứ 5, ngày 20/2/2025
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